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Chapter 1. Overview

Introduction

The Soil Resource Inventory Toolbox (SRITB) for ArcGIS provides tools and toolbars custom designed to
improve the ease and efficiency of the soil data collection.

Installation

Installation requires Administrative privileges, the previous installation of ArcGIS Desktop suite, and Microsoft
.NET support for ArcGIS.

To install the tools, double click the SRITBInstaller.msi file and proceed through the installer by clicking the
Next button. After installation, you will have several new toolbars in ArcMap and ArcScene and a new
extension available in ArcMap. The extension must be manually enabled in the Tools->Extensions menu of
ArcMap by clicking the checkbox next to SRITB. When the extension is enabled, one of the toolbars will be
displayed whenever a new document is created or opened. The Edit Task selector will be moved from the
default ArcMap Editor Toolbar to the SRITB - Edit Toolbar. Several context menu options will be added to the
built-in ArcMap editing context menus to increase editing efficiency.

Configuration

Soil Resource Inventory Toolbox can be customized through the preferences dialog. It is accessed through a
button on the SRITB - Edit Manager toolbar. The SRITB toolbars automatically dock to one side of the screen,
and can be changed from the default on the left side of the screen to the top, bottom, or right side of the screen
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Toolbars

The Toolbox provides six toolbars designed to maximize the screen space available for editing. Only one toolbar
will be displayed at a time. It will dock to one side of the screen as specified in the extension's preferences
dialog. This dialog is available on the SRITB - Edit Manager toolbar by default. You can navigate to any one of
the toolbars through the drop down menu or cycle through them using the yellow arrow buttons.

Figure 1.2. SRITB Toolbars Menu and Arrows

v Edit Manager
Edit Toolbar
Sketch Toolbar
Topology Toolbar
QA/QC Toolbar
GPS Toolbar

The Sketch and Topology toolbars contains a subset of the tools available on the similarly named built-in ESRI
toolbars. These toolbars are primarily included for the added convenience of accessing them through the SRITB
toolbar interface.

SRITB - Edit Manager

The SRITB - Edit Manager Toolbar contains the standard toolbar-switching tools and table of contents toggle. It
has tools infrequently used during actual editing. Specific tools found on this toolbar are the SRITB Preferences
button, start, stop, and save editing commands. These commands are followed by the Snapping Environment
Toggle and the Snapping Tolerance, Sticky Move Tolerance, and Stream Mode Tolerance quick change
commands. The toolbar installs with defaults set for snapping tolerance, sticky-move tolerance, and stream
mode tolerance that are most appropriate for most soil line editing.

Figure 1.3. SRITB - Edit Manager Toolbar
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The Toolbars, Previous, Next, and TOC (Table of
Contents) Tools/icons are displayed on all edit toolbars.
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Figure 1.3a. SRITB — Editor Icons
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Figure 1.3b. SRITB - Tolerance Settings Icons
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SRITB - Edit Toolbar

The SRITB - Edit Toolbar contains the tools most commonly used during digital soil mapping. It contains built-
in ArcMap commands for Explode, Edit Attributes, Edit Task and Target Selectors, custom made Streaming

toggle, Trace Lines tool, and Sketch tool.

Note

The Edit Task selector will only appear on the SRITB - Edit Toolbar if the SRITB Extension is
enabled. This toolbar is also the default location of the custom editing tools which are described in full
in Chapter 2 — Digital Editing Tools — Section: Custom Tools. Three common topology tools
are also included on this toolbar: Clear Selected Topology Elements, Validate Topology in Selected
Area, and Fix Topology Errors.
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Figure 1.4. SRITB - Edit Toolbar

SRITB - Edit Toolbar
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Figure 1.4a. SRITB - Edit Toolbar Icons
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SRITB - Sketch Toolbar
The SRITB - Sketch Toolbar contains the most commonly used ESRI Ink tools.
Figure 1.5. SRITB - Sketch Toolbar
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SRITB - Topology Toolbar

The SRITB - Topology Toolbar contains the most commonly used ESRI Topology tools.
Figure 1.6. SRITB - Topology Toolbar
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SRITB — QC Toolbar
The SRITB - QC Toolbar contains quality control tools.
Figure 1.7. SRITB - QC Toolbar
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SRITB - GPS Toolbar

The SRITB - GPS Toolbar contains tools designed to help make use of GPS data in the field. The Pedon
Autopopulation Tools are located on the GPS Toolbar, as well as tools to navigate with GPS and record an

observation point at the current location. See Chapter 4, GPS Tools, and Chapter 5, Pedon Autopopulation
Tools, for more information.

Figure 1.8. SRITB - GPS Toolbar
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Chapter 2. Digital Editing Tools

Overview
The custom designed Digital Editing tools are found mainly on the SRITB - Edit Manager and SRITB - Edit
Toolbar toolbars. They are designed to save time and reduce the amount of effort required in editing GIS data. If

you wish to use these tools on other standard ESRI toolbars, the tools can be found in the DigitalEditing
category of the ArcMap Customize dialog and drag them to your preferred toolbar.

Editing Environment

The SRITB toolbars contain several controls to help you change the parameters of your editing environment.

Table of Contents Toggle
The Table of Contents Toggle is on each of the SRITB toolbars. It shows and hides the ArcMap table of

contents when clicked. Unlike regular menu option (Window->Table of Contents), the current map scale is
maintained when the Table of Contents Toggle is used.

Figure 2.1. Table of Contents Toggle

Snapping Environment Toggle
The Snapping Environment Toggle is on the SRITB - Edit Manager toolbar. It shows and hides the ArcMap

Editor Snapping Environment Panel when clicked. This tool maintains the current map scale when it is toggled
on and off.

Figure 2.2. Snapping Environment Toggle

H]

Snapping Distance

The Snapping Distance quick change panel is accessed from the SRITB - Edit Manager toolbar. You set the
ArcMap editor snapping distance on this panel instead of loading the ArcMap Editor Options dialog. Enter the
snapping distance on the left and select units of Pixels or Map Units on the right. The panel will close itself
once you move the mouse to another task.

Figure 2.3. Snapping Distance Quick Change Button and Panel
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The Sticky Move Tolerance quick change panel is accessed from the SRITB - Edit Manager toolbar. ArcMap
editor Sticky Move Tolerance is set on this panel instead of loading the ArcMap Editor Options dialog. The
panel closes once the mouse is moved to another task.

Figure 2.4. Sticky Move Tolerance Quick Change Button and Panel
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Streaming Tolerance
The Streaming Tolerance quick change panel is accessed from the SRITB - Edit Manager toolbar. ArcMap

editor Stream Mode Tolerance is set on this panel instead of loading the ArcMap Editor Options dialog. The
panel closes itself once the mouse is moved to another task.

Figure 2.5. Streaming Tolerance Quick Change Button and Panel

s
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Streaming Toggle
The Streaming Toggle button is found on the SRITB - Edit Toolbar. It provides a convenient way to toggle
streaming mode on and off. Also, it is a visual indicator showing what mode is currently active. See Figure 2.6,

“Streaming Mode Toggle - Streaming Mode Off” and Figure 2.7, “Streaming Mode Toggle - Streaming Mode
On” for examples of how the button looks in either state.

Figure 2.6. Streaming Mode Toggle - Streaming Mode Off

<

-

Figure 2.7. Streaming Mode Toggle - Streaming Mode On

o
2

Custom Tools
The SRITB toolbars contain custom editing tools designed to reduce the number of steps required to complete

common GIS editing tasks. If there is an active edit session then all the tools will start a new session before
setting the appropriate edit task.

Reshape Edge
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Use of the Reshape Edge tool requires an active topology in the ArcMap session. When the button is clicked, it
will start an edit session then activate the topology tool, if needed. Click to select the line that needs reshaped.
Once the line is selected, the edit task will be reset to Reshape Edge and the sketch tool will be activated. Draw
the sketch to reshape the line and double-click to finish.

Figure 2.8. Reshape Edge Button

21

Modify Edge

Use of the Modify Edge tool requires an active topology in the ArcMap session. When the button is clicked, it
will start an edit session. Set edit task to Modify Edge then activate the topology edit tool. This tool can be used
to select and modify edges in the dataset.

Figure 2.9. Modify Edge Button

g

Cut Polygon

The Cut Polygon button will start an edit session and activate the feature selection tool. Click to select the
polygon that needs split. The tool will detect your selection and activate the cut polygon edit task, and sketch
tool will draw the cut line. Double-click to finish. After the cut is performed, the tool will perform an explode if
any of the cut features were multi-part polygons. The default behavior is to show the Edit Attributes window.
This behavior can be changed in the preferences dialog by unchecking “Display Attribution Window” after “Cut
Polygon”. See more information in the section in Chapter 1. - “Configuration”.

Figure 2.10. Cut Polygon Button

o
Create Island Polygon

The Create Island Polygon tool will start an edit session and activate the feature selection tool. It also sets the
editor snapping properties so that they snap to edit sketch vertices. This allows the creation of an island polygon.
Click the feature that contains the island to select it. The tool will set the edit task to cut polygon and activate the
sketch tool. This tool can be used to draw the island polygon. Double click to finish the edit sketch and the tool
will perform an explode if any multi-part polygons are present. Then the tool will display the edit attributes
window if the “Display Attribution Window” after “Cut Polygon” is checked in the preferences dialog. It will
reset the snapping properties to what they were before running the tool. If “Continue Cutting” is checked after
the “Create Island Polygon” box in the preferences dialog, snapping properties will be reset to what they were
before running the tool. See more information in the section in Chapter 1 - “Configuration”.

Figure 2.11. Create Island Polygon Button

te

Auto Complete Polygon

Use of the Auto Complete Polygon tool requires an active topology in the ArcMap session. When clicked, the
button will start an edit session and then set edit task to Auto Complete Polygon. This will activate the sketch
tool allowing you to add polygons to an existing layer.
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Figure 2.12. Auto Complete Polygon Button

-
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QC Toolbar

Chapter 3. Quality Control (QC)
Toolbar

Figure 3.0 Access the QC Toolbar from the SRITB Edit Manager Toolbar
| * adair.mxd - ArcMap - ArcInfo

‘| Eile Edit View Insert Selection Tools Window Help !
Toobars * &= = e R
¥ Edit Manager hjects, ‘
T Edit Toolbar g
Lo ‘E‘“" “:5:‘5*9
I Sketch Toolbar F s FAEIER R
Topology Toolbar |E b ‘ SCHE “1:3,4% ] HE‘
T QAMC Toolbar ; Iy _
by = % @ - Load Ohjects. | 2
L GPSToobar ' M : .
A bk ]
£
Toolbars = <= =@ |QC Extent™ |Q§: % 2 g By
The QC Toolbar contains five tools
QC Error Inspector (finds and fixes errors)
*  Find minimum size polygons
*  Find common soil boundaries
Find label mismatches
Find edge mismatches
Figure 3.1. SRITB - QC Tools
~ i Y
el ac
QC Extent™ = T B Ly E!!I
Extent Finds Finds Finds Finds Finds
Selection | and Fixes | Minimum | Common Label Survey
‘ Inspector Sized Lines Sub-Area
Polygons Edge
IT Full Extent
Visible Extent
Selected Features
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GPS Toolbar

QC Extent Button

QC Extent can show full extent, visible extent, and selected features. When running a task on a smaller area, use
the selected features option rather than visible extent because it runs faster.

Figure 3.2. QC Extent Button

QC Extent¥

Toolbars v < =  |QUExtentr |[£ & % ' %
v Full Extent
= & Layers - Visible Extent

= @ march15 Selected Features

Use: Select extent prior to using any of the QC tools
—  Full Extent
— Visible Extent

—  Selected Features
Find Minimum Sized Polygons

Figure 3.3. Minimum Sized Polygons Button

ac
e

USE: Find small polygons to potentially be merged with adjacent
polygons

1. Stop Editing Session

2. Left click on soils layer name in the Table of Contents to highlight (may be a geodatabase featureclass
or shapefile)

El £F Layers
= molz2l_a

3. Click on the Find Minimum Size polygon task icon on toolbar

12



GPS Toolbar

4. Enter a value for area in either acres or sq. meters (You do not need to have an Acres field in the
attribute table.)

Minimum Size Polygons S x|

Find polygong with area less than
H I.-'-‘-.u:res LI

| Run Tazk I Cancel |

5. Run task

6. Click on QC error inspector icon to display polygons smaller than specified size

B3 Quality Control Er

Show mules from this task: L

Tazk Mame | Feature Clazs | Feature Clazs | Feature 1 | Feature 2 | Fieazon
b | Minimurn Siz - mol21_a 156 Smaller than
| |Minimurn Siz - mol21_a 177 Smaller than
| |Minimurn Siz - mol21_a 497 Smaller than
| |Minimurn Siz - mol21_a 583 Smaller than
| |Minimum Siz  mal21_a 705 Smaller than
| |Minimum Siz mal21_a 828 Smaller than

Minimum Siz - mol21 a 1085 Smaller than

7. Leftclick on a row in the table to select a feature

| ™, A f
Quality Control Error Inspector =l
Show rules from this task: I ;I
| Feature 2 | Reason
Zoom To Feature(s) ; C rmallet tha
Wi Fan To Feature(s) v Sraller that
Mir  Select Feature(s) ] Srnaller than
Mir  Select and Zoom to Feature(s)  F Smaller thar
rir H Smaller than
Mir  Merge 23] Smaller than
Clear Item
Flag Itemis)

8. Right click on the selected row to display options

9. Select and zoom to a feature using one of the zoom/select options

13



GPS Toolbar

Zoom To Feature(s)

Pan To Featurels)
Select Featurels)
Select and Zoom to Featureds)
Save All Features to Shapefile

Merge

Clear Ikem
Clear all Ikerns

10. Select Merge to merge selected small polygon with an adjacent polygon if needed.

11. If the selected polygon is an “island” polygon, it is merged with the surrounding polygon.

._una;—.i-

12. If the selected polygon is bordered by multiple polygons, an attribute box will appear:

Select a feature to merge with:

(] 8 | Cancel |

Z|

a) Click on the Object ID in the left pane and the associated polygon will Flash on the screen.
Click OK.

b) Select the polygon that has the desired attributes to retain

If you do not have time to deal with all of the errors in one session, you may save all of the features to a
shapefile for future reference.

1.

2.

Right click on any record in the QC error inspector table

Select Save All Features to Shapefile

Zoom To Featureis)

Pan To Feature(s)

Select Feature(s)

Select and Zoom to Feature(s)

Save All Features ko Shapefile

Merge

Clear Item
Clear &ll Ttems

14



GPS Toolbar

3. Navigate to output location and give the new shapefile a name
4. Save all features to a shapefile. The new shapefile is automatically added to the map document.

TIP: Once you have finished using one of the QC tools, you should clear all records from the table before
running another quality control task.

Zoom To Feature(s)

Pan To Featurels)

Select Feature(s)

Select and Zoom to Featureds)
Save All Features to Shapefile

Merge

Clear kem
Clear all Ikerns

If you do not clear the records, they are carried over from one task to another. The records are cleared out of the
table when you quit. The results from multiple tools can cause confusion so it is best to clear the tables after
each tool is used.

Find Common Soil Boundaries

Figure 3.4. Find Common Soil Boundaries Button

2

1. Stop Editing

2. Select extent for task
—  Full Extent
— Visible Extent

—  Selected Features

Toobars v < = . |QCExtent |& & % i &
'~ Full Extent
= & Layers = Visible Extent

= ¥ march15 Selected Features

i

When running a task on a smaller area, use the selected features option rather than visible extent. It runs much
faster!

15



GPS Toolbar

3. Leftclick on soils layer name in the Table of Contents to highlight

E £F Layers
=

(.

4, Choose the common soil line task icon on toolbar

Qs QC

B =

5. Wait for message box to appear when task is complete. *Click OK

Finished finding Common Soil Boundaries!
Found 3 error(s),

Open the Error Inspectar ko find them!

6. Process uses a lot of resources. Avoid running other processes at the same time

* Note that features will appear in the error inspector as they are found. Wait until the process is completely
finished to avoid processing errors

7. Click on QC error inspector icon to display polygons with common soil boundaries

Quality Control Error Inspector P
Shiow rules from this task: I LI
Task Mame | Feature Class | Feature Claszs | Feature 1 | Feature 2 | Feason H
u Cammot Sail | mal01_a mol071_a Palygonz bath have MUSYR: 50001 l
. Cammot Sail - mol01_a mol07_a 1365 1424 Palygonz bath have MUSYR: 50007
. Cammot Sail - mol01_a mol07_a 1396 1424 Palygonz bath have MUSYR: 50007
. Cammoti Sail - mol01_a mol07_a 1434 1424 Palygonz bath have MUSYR: 50007
G | 07 & mol01 a 1458 _ 141 Prluannz binth hasge MIS M- 5OOO
‘01 iL Common Soll - mol01_a modil_s 3525 155149 Pualygons bath have MUSYM: B0z

8. Left click on a row in the table to select a feature

16



GPS Toolbar

9. Right click on the selected row to display options

Zoom To Feature(s)

Pan To Feature(s)

Selact Feature(s)

Select and Zoom ko Feature(s)
Save All Features to Shapefile

Merge
Edit Attributes

Clear Trem
Clear All Items

10. Select and zoom to a feature using one of the zoom/select options

11. Two Edit Options:

e Select Merge to merge adjacent polygons if needed

»  Select Edit Attributes to change an attribute if needed
12. Merge feature

»  When selected, both polygons sharing a common boundary are highlighted

o010 A\ s 7 P
@ ( e 0011
S n |
A ) [N =
i ( S\ SN
N / \ \ — N
[Quaiity Control Error nspecton |
I 7
( /,-' 7 Shows rules from this task: ]'
m:"'_,'//'k‘ [Tockane | Foaue Class Feahan Clss | Feape ] Fostae 2 Roan
i = L CommonSol [molM_a  mollla 143 1421 | Pelygons be
o o b
= L ConmnSol w0l s ol a 1458 2l Pelyguns be
'I_. U Common Sol | mo001_a moll1_a 325 15519 Prlvgons he
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13. Edit Attributes feature

— Attributes window opens allowing user to edit attribute of each selected polygon
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| 3K 14 ame FEAlUe LIass | Fealure Liass | real

Comman Soil - soilmu_a_re  soilmu_a_ne 339
I P

[l Common 5ol
Zoom To Feature(s)

Pan To Features)
Select Feature(s)
Select and Zoom to Featureds)
Save All Features to Shapefile

Comman Soil

Merge

Clear Tkem
Clear All Items

14. Click on polygon attribute in left pane and the polygon will flash

15. Change the attribute in right pane

Attributes @ Currently Sharing [¥]

=-soilmu_a_ne159 Property | Walue

A FID 1427

W areasymbol ME1S9
spatialver 1

MMUSYT
mnikey a7

16. (Optional) Copy text from find minimum size polygons task. Export out All of the Errors to a
Featureclass or shapefile.

* Right click on any record in the error inspector table

e Select Save All Features to Shapefile

| Zoom To Feakure(s)
Pan To Feature(s)
Select Featureds)
Select and Zoom to Featureds)

Save All Features to Shapefile

Merge

Clear Tkem
Clear &ll Items

17. Navigate to output location and give the new shapefile a name
18. Save Edits. Edits are not automatically saved when using the error inspector.

19. Clear all records from the table before running another quality control task (Rt. Click > Clear All
Items).
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Zoom To Feature{s)

Pan To Feabure(s)

Select Featurels)

Salect .and Foom bo Fakturss)
Sawve All Features bo Shapefile

Merge
Edit Attribubes

Clear Them

Clear Al Tems

Find Label Mismatches

Figure 3.5. Find Label Mismatches Button

by

1. Add adjacent shapefiles or feature classes to map

2. Click LM task icon on toolbar

(B By

3. Select: Search symbol, Survey Sub-Areas, and Error Tolerance from drop downs

4. Click Search button

& Find Label Mismatches -0 x|

Search Symbal: IMUSYM - I

Survey Sub-drea 1: ImoDD1_a 'l Survey Sub-frea 2 E
Search | Progress: Error Tolerance: 3 IMEtETS 'l

Identified P olpgons

-

Show Symbol M appings I Done I

5. Left click on a row of identified polygons to zoom to and select

6. Right click on row to open Replace Symbol options

19



GPS Toolbar

= dg [ am | \ A=
@ Find Label Mismatches - 0] x|

Seaich Symbat [MUSYM VI
Survey SubAreat:  |mol0_a 'I Survey Subdrea2  |mol2i_a 'l

ul
Sech | pogess 100% Canplte Enor Torance: | 3 [Heles =

Identified Polygons

3731 60206 10934 50201

[ Replace Symbol - 1

Show Syrbolepoings | Done- || Symbolto Change: | =

NewSymbol: [ ﬂ

7 T 77
y
I -

7. Select symbol to change from drop-down list

Replace Symbol
Symbolto Change:

60206

=
Mew Symbol: |gnom k. |

8. Enter New Symbol, click OK

R eplace Symbol
Symbol to Change: 60205 ~|

Hew Symbol: |E|:|2|:|‘| (] |

9. Change is saved automatically, no undo!
10. Run label mismatch task again after editing labels

11. Switch Sub-Area 1 and Sub-Area 2 to ensure all label mismatches are found

Find Survey Sub-Area Edge Mismatches

Figure 3.6. Find Survey Sub-Area Edge Matches Button
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By

1. Add adjacent shapefiles or feature classes to map

2. Click EM task icon on toolbar

Bt |

3. Select: Search symbol, Survey Sub-Areas, and Error Tolerance from drop downs

4. Click Search button

& Find Label Mismatches - 0| x|

Search Symbok IMUSYM - I

Survey Sub-frea 1 ImDDD'I_a "I Survey Sub-brea 2
Search | Progress: Error Tolerance: I 3 IMBthS "I

Identified Polygons

Shaow Symbol Mappingz | Done |

5. Left click on identified polygons to zoom to and select

6. Use appropriate editing tools to match edges

1
BN & Find Edge Mismatches _ (o] seffer | gl ezl
< Search Symbot [MUSYM =
[
Survey Subduea 1 mol01_a - Survey Subdrea 2 |mol2l_a vl G | — 0001

Search Progress: 100% Complete: Eior Tolerance: | 3 [Mews =] |\

Identified Polygons o | L
| [AD1 | MUSYM1 | FID2 | HUSYM2 i
R R 15515 |60201 |10832 |60208 |

EL 60206 10892 60206
*

w | £0206
’.‘ ﬁ E0203
I 7

7. Run edge mismatch task again after editing polygons

8. Switch Sub-Area 1 and Sub-Area 2 to ensure all edge mismatches are found
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Chapter 4. GPS Tools

GPS Connection Parameters

This button brings up the ArcMap GPS Connection Setup screen. Use “Detect GPS Port” button and “Test
Connection”. If both of these buttons are successful, click OK to close the dialog. If one or both fails, manually
select connection parameters until the “Test Connection” button is successful.

A communication port of COM3 and Baud Rate of 4800 is common for some built in GPS receivers. The com
ports that ArcGIS selects will generally range from 1 to 9. Typically ArcGIS will choose the same port over and
over again on a particular computer.

Figure 4.1. GPS Connection Parameters Button and Dialog

- ==
-

GPS Connection Setup ed |

— Specify ¥our GPS connection

% Connect to GPS receiver

Communication Part: II:DM‘I j Detect GPS Part |

B aud R ate: I 4300 - I Crata Bits: I a - I
P arity: IN.:.ne TI Stop Bits: |1 "I

Test Connection |

Daturn Used On GPS Receiver |GC5_wE5_1384 =]

i Simulate GPS connection using paint or line data

[Layer; I ;I EI
| mtereal: |1 000 3: Seconds

k. I Cancel

Activate GPS

If the GPS is connected and the connection parameters are properly set (see the section called “GPS Connection
Parameters”), click this button to activate the GPS and display the current location on the map.

Figure 4.2. Activate GPS Button

.ok
P2
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Display GPS Info

This button brings up a panel showing detailed information coming directly from the GPS.

Figure 4.3. Display GPS Info Button and Info Panel

Hi
=
L afitude: 29 98 1" N ':Ihtuif: 319.300 M-eters
Longitude: 2g0 BT 14" DEB.. M A, Kilormeters/Hour
Heading: I, Deqgrees [true]
Ctatuz: Connection open. Beceiving data, [GPS on COM1] . Simple << |
IITC Time: 16:54: 20 — Diilution of precision
UTEC Date: 06/02/06 HDOP: N/
blag. Yanance: 2.9 Degrees WDOP: M4
Cuality Indicator, WA FOOF: /&
S atellite &xyveailability — Differential GPS
Satelite Count: 11 2 MAA Station [0 WAA
Average SHE: [ A, Age: M A2,

Navigate Using GPS
This tool brings up a window to show the current map. To navigate to a specific place on the map, click on the
map to place a MARK. The window will show the distance and the bearing to the mark from the current GPS

location, as well as a compass showing the direction of travel. Click “Go To Next MARK?” to clear the mark
from the map to place another MARK.

Figure 4.4. GPS Navigation Tool Button and Window

w

Distance: | 1008.27
Bearing|195.53
Uris: [Meters -

Go To Next MARK

Travel Bearing
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Collect a GPS Observation Point

This tool creates a new point feature using the current GPS location. The point is stored in the first layer in the
ArcMap session with _op in the layer name. Click the Offset button to enter a distance and bearing to offset the
current location. Click the Hyperlink button to link the new point to an external file (picture, video, sound, etc...)
with ArcMap's hyperlink tool. After entering the point's information, click Store Feature to save it.

Figure 4.5. Collect GPS Observation Point Button and Dialog

& Collect Point Feature E”E| @

Offset Hyperlink |

Define Observation Point Attributes

Site 1D |

Observation -
FTVEHOn |Field Note |

Collected |
by

Notes |

Store Feature |
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Chapter 5. Pedon Autopopulation
Tools

Introduction

The Pedon Autopopulation Tools are designed to automatically fill out location and site data using geospatial
layers. It also integrates with a GPS if one is available. A user can specify a location or a group of points in
ArcMap. The location is intersected with various data layers on the user's computer to gather data to insert into
the pedon database.

Setup
In order to use the Autopopulation Tools, the following software needs to be installed:
» Microsoft Access 2003
e Pedon PC
The Autopopulation Tools can be found on the Pedon Autopopulation Toolbar or the SRITB - GPS Toolbar.
Autopopulation uses specifically named layers in the ArcMap document to gather data. The following table list

layer names and attribute fields currently used. If any of these layers do not exist, the Autopopulation Tools will
not be able to populate the corresponding items in the pedon database.

Table 5.1. Pedon Autopopulation Data Layers

Pedon Field Layer Name Attribute Field Name
Area Overlap - Non MLRA SSA soilmu_a areasymbol
Area Overlap - State county_dm_a STATE_FIPS
Area Overlap - County county dm_a COUNTY_NAM
Area Overlap - 7.5 Min Quadrangle quads24K QUADNAME
Area Overlap - MLRA mlra MLRA_NAME

When creating new pedons, the Autopopulation Tools will create a new point in your spatial data as well as the
new Pedon database records. This spatial point will be created in a layer with _dp in the name. It will have the
new pedon’s user pedon ID recorded in an attribute field named user_pedon_id. The user site ID is recorded as
user_site_id if those fields exist. If this layer does not exist, no spatial record will be created, but new pedon's
coordinates will still be recorded in the pedon database.

Usage

There are two modes of operation: Create New Pedon and Update Existing Pedon. Either mode requires the user
to specify a user pedon ID. In new mode, the pedon will be created if there is no existing upedonid matching the
user-supplied one and displaying an error message if it already exists. Update mode is exactly the reverse. It will
autopopulate existing pedons and display an error message if the supplied upedonid cannot be found in the
pedon database.

Pedon PC Autopopulation has three interface modes. GPS mode will use the current GPS position to
autopopulate. Selected Points mode autopopulates multiple pedons at once using a selected set of points from
ArcMap. The third method is an ArcMap tool allowing the user to click on the map to autopopulate at the
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clicked coordinates.

B & IR

GPS Mode

In this mode, a connection must first be established to the GPS. Load the GPS toolbar in ArcMap. Open the
GPS Connection Setup menu and use the Detect GPS Port button followed by the Test Connection button. If the
connection test fails, modify the settings using the dropdown menus until it succeeds. Click the Open
Connection button on the GPS toolbar.

To start the autopopulation with the GPS, click the Autopopulate from GPS icon in the Pedon Autopopulation
Toolbar. It will prompt you for a user pedon ID and user site ID. Leaving the user site ID field unchanged or
blank will result in the user pedon 1D being used for the user site 1D as well.

This method creates a point, there should be a layer in the ArcMap document with the text _dp in its name and
attribute fields named user_pedon_id and user_site_id. The user pedon ID supplied will be written to the
new point's user_pedon_id field, and the user site ID written to user_site_id. The tool will write the
latitude/longitude and UTM data. If there are any of the layers found in Table 4.1 “Pedon Autopopulation Data
Layers,” that data will be written to the area overlap table.

After it is finished writing, the data tool will launch Pedon PC to allow the entering of a description for the new
pedon.

Selected Points Mode

This method is useful for populating a large group of points. Waypoints can be downloaded from the GPS into
ArcMap using DNRGarmin and then pedons can be created from a selected set of them. To use the tool, select
one or more points from any data layer in ArcMap. This function will not add the points to the documentation
points layer, but that will be an option in the future. This tool scrolls through the attribute fields of the selected
points and displays a dropdown menu listing them. Select a field containing text to use as user site IDs for the
new pedons. The tool will write the same data items as described in the GPS Method section and start Pedon
PC.

Click Tool Mode

Choose the click tool. Click a location on the map to create a point.

This method creates a point. There should always be a layer in the ArcMap document with the text _dp in its
name and attribute fields named user_pedon_id and user_site_id. The user pedon ID supplied will be
written to the new point's user_pedon_id field, and the user site ID written to user_site_id. The tool will
write the latitude/longitude and UTM data. If there are any of the layers found in Table 4.1 “Pedon
Autopopulation Data Layers,” that data will be written to the area overlap table.

After it is finished writing data, the tool will launch Pedon PC to allow the user to enter a description for the
new pedon.
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Chapter 6. 3D Data View

Introduction

The 3D Data View tool is designed to clip layers in ArcMap and send them to ArcScene.

Setup

In order to use the 3D Data View Tool, the Soil Resource Inventory Toolbox Extension for ArcGIS 9.2 version
1.1.18 must be installed:

To add the “3D Data View toolbar to Arc Map, choose View > Toolbars and check the 3D Data View choice.

Figure 6.1. Select the “3D Data View” toolbar

File Edit |view Insert Selection Tools ‘Window Help

3D Analys @ Data view
= Layauk Yiew

0 =

B L

& |[1:12.000

Zoom Data 3

=

=5 Zoom Layout 3

T ¥

" Bookmarks .
r Toolbars

T v Skatus Bar

=

Crverflow Annotation eI

Advanced Editing

I Scrollbars

Use of the 3D Data View Tool

This example presents the application of this tool in an ArcMap session with elevation survey points, soil map
unit polygons, DOQ image, 10m NED ESRI Grid.

Soil map units are symbolized with hollow fill and yellow outlines.
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Figure 6.2. Adjust the display to the area of interest to be displayed in ArcScene

File Edit View Insert Selection Tools Window Help

30 Analyst » | Laver. [ wiltom_utm Sl es LS ®
PO &b B B X a e | & fi200 -l & @O Layer: [ wil1Gur_uan

Layer Selection for 3D Viewin ArcScene

ListofLayersinTOC List of Selected Layers
PROFILE FROFILE
91

soilmu_a_tx491
Add Layer >> ortho_e1-1_s_tzd91 sid
il Orn_utrn

Yiew 3D Data Cancel

One at a time, select the layers from the list of layers in the TOC (table of contents) and click the “Add Layer
>>" putton, or hold the shift key down to select more than one layer to add at one time.

Once the layers have been selected, click on the “View 3D Data” button.
Arc Scene will automatically activate.

The layers will be added with the existing symbology present in ArcMap.
The elevation layer will automatically be turned off.

The image layer will automatically be set to rendering level of 10.
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Figure 6.5. This is an example of an image ported to ArcScene via the “3D Data View”
Tool.

1&" Untitled - ArcScene - Arclnfo

File Edit Wiew Selection Tools MWindow Help

DSESE| 0 =0 + 8@ WY o
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&
&
;
&
g
3
»
€
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#
é
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Set 3D ... [X]
= PROFILE

= B spimu a Exd91

= O willlom_utm
i | Value

ioh ¢ 342,257
E&\% ‘ I Low : 264,439

= artho_gt-1_s_tw431.sid.sid
RGE
I ll . ued: Band 1
I | [ Green: Band_2 ”
-me: Band 3 _

Dizplay

—

Figure 6.6. Set the base height

% Untitled - ArcScene - Arcinfo

File Edit View Selection Tools ‘Window Help

DSH& 20X ¢ @ Qe we

= Layers
[= PROFILE

= soiimu_a_tx491 Sets 30 Properties such as Base Heights|

SR will 10m_ukm
Walue
High : 342.257

To set the base height, the elevation layer must be selected first by highlighting it. Then, click on the button that
sets the 3D properties. This process can take a minute or two depending upon the size and complexity of the
layer.
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Figure 6.7. Results of the base height being set

£k Untitled - ArcScene - Arcinfo

File Edit W¥iew Selection Tools ‘Window Help

== = ¢ B @QLdpow PrROQGGAG I
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= ortho_e1-1_s_tx491,sid.sid
RGE
.Red: Band_1
=- Y tareen: bana_c
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Figure 6.8. The next step is to set the Vertical Exaggeration.

Bf:_u:-.:: Yertical Exaggeration for the Scene|

e

The button on the right sets the vertical exaggeration.

Figure 6.9. Choose the Vertical Exaggeration from the drop down menu.

Set Vertical Exaggeration |: E'E'

Select Vertical |E =

E xagoeration Y alue:

1.5

i ‘ 10
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Figure 6.10. Zoom in or fly into the scene to view features and imagery draped on the
elevation surface.

% Untitled - ArcScene - Arclnfo

‘ File Edit Wiew Selection Tools Window Help

DEE& =8 ¢ @ Qa0 K [~ aeQaQuNZO@ER

Set 3D ... [¥]

Il *1Te =

When completed with 3D view, close ArcScene application without saving the document.
This automatically deletes all files created except the clipped elevation data.

When the tool is activated in ArcMap again, this temporary elevation data stored in the
C:\temp\Launch3DView folder will be deleted.
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Chapter 7. ND83 — W(G84 Buttons

Introduction

The Convert2Nad83 Tool looks at the Microsoft Access pedon.mdb site table for lat/long,
datum and UTM values. It then converts Nad1927 values to the NAD1983 datum and outputs
lat/long decimal degree values in the SiteNad83 Pedon PC database table. Rows that cannot
be converted are reported in a text document — “incompletesiteids.txt”.

Figure 7.1. Pedon Autopopulation Toolbar with ND83 and WG84 Buttons

Pedon AutoPopulat...[X]
E E [:& HD WG

Usage

The steps to use the Convert2Nad83 Tool are as follows:

Open ESRI ArcMap application.
Go to the Tools menu and click on Customize option.
Check the Pedon Autopopulation Toolbar if it is not already checked.

Click the . icon on the toolbar.

M owneE

Unless the SiteNad83 table is already full, there will be a progress bar on the bottom left
corner of the ArcMap window. After the progress bar hits 100%, there will be a confirmation
message, “Nad83 Transfer/Conversion complete”.

Program Functionality

The SiteNad83 and SiteWGS84 output tables have four fields: siteid, Latitude, Longitude and
description. The siteid field is the imported site table primary key field. The Latitude and
Longitude fields are the lat/long values displayed in decimal degrees. The description field
contains a code from 0 to 5 indicating the conversion type.

Documentation of the codes generated to populate the incompleteSitelDs report that results
from running the Convert2Nad83 Tool are as follows:

Code O

If the site table record has lat/long values and a datum value equal to Nad83, then the code
“0” is returned in the SiteNad83 table description field. This code reflects no conversion
performed.
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Code 1

If the site table record has lat/long values and a datum value not equal to Nad83 (it is Nad27),
then the data is converted to Nad83. The code “1” is returned in the SiteNad83 table
description field.

Code 2

If the site table datum field is empty or one of the lat/long values is empty, then the UTM
values (UTM Zone, UTM Northing and UTM Easting) are checked. If the UTM values are
available, then they are used to do the conversion. The code “2” is returned in the SiteNad83
table description field.

Code 3

If the site table datum and UTM Zone fields are empty, then the lat/long values are checked.
If the lat/long values are available, then they are used to calculate the UTM Zone. If the UTM
Easting and Northing values are also available, then they are used to do the conversion. The
code “3” is returned in the SiteNad83 table description field.

Code 4 and Code 5

If only the lat/long values are available, then the datum is calculated using the site obs table
site observation date field. If the year designation is greater than or equal to “1983” then
Nad83 is assumed, otherwise Nad27 is assumed. The code “4” is returned in the SiteNad83
table description field if Nad83 is assumed. The code “5” is returned in the SiteNad83 table
description field if Nad27 is assumed.

If there was insufficient information available for the conversion, a text file with the default
name “incompleteSitelDs” is generated and the codes listed above are included in the report.

Sample Tables

Shown below are the site and site observation tables in the pedon.mdb database and the Site
Nad 83 table in the pedon_pc.mdb database.

Table 6.1. Site Table

[mseirable -l x]
| [Rec D[ User Site ID
’

1/ 29MTE450102 46 19 14,3656

1 1 5.2032 2
2 00MTES50089 1791312 1 s} 39.995586 2 2
3 00MTE3E0096 46 a6 48.83532 1 114 1 1.056064 2 2
4 00MTE3E0095 46 a5 33.2849 1 114 1 38.57966 2 2
5 00MTE3B0093 46 55 71687901 1 114 1 4919694 2 2
B 00MTE350094 46 55 16. 76597 1 114 1 47 45493 2 2
7 00MTE3E0092 46 a6 58.81734 1 114 B 47 32352 2 2
4 00MTEIB0091 46 a6 47.03355 1 114 5 30.51019 2 2
9 00MTE3E0090 46 56 40.4578 1 114 B 14 20655 2 2+
Record: 140 4 [ T b |1 |b#] of 1625 K| _»l_l
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Table 6.2. Site Observation Table

_lo/x
Migrated Site Rec |0 Obsenation Date

i ST
2 B/8/2000 m
3 BA15/2000 il
4 BA15/2000 i
5 B/15/2000 H
5] BA152000 &
7 B/8/2000 i
8 B/8/2000 B
g B/B2000 ||| pacord
14 | 1k | v e oF 16276 s
Table 6.3. Site NAD-83 Table
B I=

46.9353092

|- =2 i 3l - . J-F_I iﬁi-ﬁ ' 1]
. g 46.9466204305556 -1 11‘1 108478052778 0
9 459445799444444 0 114 103946272222 0

Record: I4| 1 || 1k |H |H9| af 1621

WG84 Button

The WGB84 button works similar to the ND83 button. It is provided for regions of the
globe outside of North America for which WGS84 is a more appropriate datum to
use.

Pedon AutoPopulat...[X]
n E L& HI:I "."'."G
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